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1 Description générale des fonctionnalités

! Remarque ! 

Le présent manuel est une description complémentaire pour une option logicielle 

spéciale. Des informations détaillées figurent sur le CD-ROM fourni.

Le présent manuel ne remplace pas le manuel de mise en service faisant partie de la livraison !

La documentation complète comprend :

• le présent manuel complémentaire

• le manuel complémentaire Eaux usées + déversoirs d'eau de pluie (en option)

• les Instructions condensées sous forme papier

• un CD-ROM avec les fichiers PDF des documents suivants :

– Manuel de mise en service

– Agréments et certificats de sécurité

1.1 Conditions et historique des logiciels

L'option "Téléalarme" est supportée à partir du logiciel PC Version V1.25.0.0. La version actuelle 

du logiciel PC est comprise dans la livraison. Conseils d'installation voir manuel de mise en service 

sur CD-ROM.

Aperçu de l'historique du software de l'appareil :

1.2 Description de la fonction téléalarme 

(envoi de message)

En présence de divers événements l'appareil peut envoyer

• SMS (uniquement par GSM ou modem GPRS)

• des messages au logiciel PC (également possible avec modem standard analogique ou ISDN)

• des e-mails (seulement via Ethernet)

• des SMS et e-mails en parallèle (seulement via Ethernet et modem GSM ou GPRS)

Ces SMS/messages/e-mails contiennent les informations suivantes :

• date/heure de l'événement dans le format horaire réglé dans l'appareil

• nom de l'appareil saisi (Device Tag)

• ID message univoque généré par l'appareil (seulement pour SMS si la fonction "valider message" 

est active)

• message sous forme de texte

Par événements on entend :

• des dépassements de seuil (un message au début et à la fin du dépassement)

• le changement d'état d'entrées numériques ou de voies mathématiques (pour un résultat "Etat")

! Remarque ! 

• En présence de plusieurs événements simultanés, ceux-ci sont envoyés successivement. 

On pourra alors avoir une temporisation dans l'acheminement du message (pas d'alarme en temps 

réel).

Version / Date 

software appareil

Modifications du software Version du software PC Manuel de mise en service / date

V2.00.00 / 12.2008 Option téléalarme intégrée V1.25.0 et plus BA268R/09/12.08

V2.00.04 / 04.2009 Corrections de fonctions V1.25.5 et plus BA268R/09/07.09

V2.10.00 / 02.2011 Extension de fonctions V1.27.3 et plus BA268R/09/01.11
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Fig. 1: Différentes possibilités d'envoi de messages de téléalarme

1.3 Statistique alarme

Par le biais des cycles d'exploitation de signal, on détermine les données suivantes :

• Combien de fois le seuil a-t-il été dépassé (fréquence) ?

• Quelle est la durée totale du dépassement de seuil (durée au format horaire 0000h00:00)

La statistique alarme est désactivée en standard. La statistique alarme est générée pour chaque 

exploitation de signal active (même durée). 

Dans le cas d'exploitations de signal externes, aucune statistique d'alarme n'est générée pour la 

durée pendant laquelle l'exploitation n'est pas active.

La statistique alarme est générée uniquement pour les seuils "analogiques" (haut, bas ou gradient). 

Aucune statistique n'est générée pour les "seuils sur compteur".

! Remarque ! 

Afin de déterminer la fréquence, la réaction ne se fera que sur le flanc Low --> High. Si le seuil est 

déjà dépassé au moment du démarrage de l'exploitation, la fréquence n'est généralement pas 

augmentée. 

Exemple : seuil constamment dépassé de 08:59:50 à 09:01:10, cycle d'exploitation 1 minute :

Modem

SMS

Ethernet

Email

RS232

GPRS
Modem

Router

Alarme
Modem

PC Software

RS232

SMS
GSM

Modem

Relais

Ethernet

RS232

Période Fréquence Durée

08:59:00 – 08:59:59 1 10 s

09:00:00 – 09:00:59 0 60 s

09:01:00 – 09:01:59 0 11 s
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1.4 Sécurité et risques

! Remarque ! 

Le système d'exploitation utilisé par l'appareil n'offre aucune possibilité d'attaque de ce dernier. 

Par ailleurs aucun virus ne peut être propagé (e-mail). Aucun code nuisible ne pourra être transmis 

à l'appareil par SMS ou MMS.

! Remarque ! 

Le fabricant n'assume pas la responsabilité pour une transmission en temps réel des messages 

alarme. Les effets externes comme la disponibilité des fournisseurs d'accès ou une interruption du 

réseau (Ethernet) peuvent empêcher une transmission de l'alarme.

2 Réglage de l'appareil, configuration de 
l'application

2.1 Fil conducteur pour la programmation

1. Installez et paramétrez l'appareil tout d'abord comme décrit dans les chapitres 1 à 6.4 

(voir CD-ROM fourni). Tenez compte de tous les conseils de sécurité !

2. Reliez le modem à l'appareil. Tenez compte des remarques sous "Type de modem" à la page 8 

du présent manuel.

3. Initialisez le modem dans le menu principal "Diagnostic / Simulation -> Initialiser modem" 

(voir chapitre 5.6.4 du manuel de mise en service sur le CD-ROM fourni). 

4. Vérifiez la disponibilité du réseau, voir chap. 2.6.6 du présent manuel.

5. Procédez aux réglages supplémentaires nécessaires à la fonction téléalarme (voir chapitres 

suivants).

6. Testez la fonction téléalarme, voir chap. 2.6.8 et chap. 2.6.9 du présent manuel.

7. Configuration de l'affichage, c'est-à-dire préparation des valeurs pour l'affichage et sélection du 

mode de représentation. Voir aussi le chapitre 6.5 et suivants du manuel de mise en service 

(voir CD-ROM fourni).

2.2 Configuration - Application - Téléalarme

Réglage de l'alarme via un modem relié à l'appareil ou par e-mail.

! Remarque ! 

Selon la fonction choisie, l'interface utilisateur s'adapte de sorte que seuls les paramètres nécessaires 

à un fonctionnement sûr de l'appareil doivent être vérifiés/réglés.

Fig. 2: Configuration - Application - Téléalarme
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Positions de menu 

"Application - 

Téléalarme"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code

Sous-menu 

"Généralités"

Réglages généraux pour le mode téléalarme.

Fig. 3: Configuration - Application - Téléalarme, sous-menu "Généralités"

Téléalarme active "Non" : Fonction téléalarme est désactivée.

"Oui" : Fonction téléalarme est activée.

Liste de sélection : Non, Oui

63000/000

Si erreur Commute le cas échéant un relais, lorsque toutes les tentatives d'envoi 

d'un SMS ou d'un e-mail ont été infructueuses.

! Remarque ! 

Le relais peut être remis à zéro manuellement en cas de défaut dans le 

menu principal sous "Diagnostic / Simulation -> Relais".

Liste de sélection : non utilisé, Relais x (xx-xx)

63075/000

Sous-menu "Config. SMS / 

logiciel PC"

Réglages nécessaires lorsque vous souhaitez envoyer des alarmes par 

SMS ou des messages au logiciel PC.

Nombre de tentatives

Nombre de tentatives de sélection. Si aucune liaison ne peut être établie, 

plusieurs tentatives sont faites (jusqu'à ce que le nombre max. réglé ici 

soit atteint). 

Entrée : 1 à 99 ; réglage par défaut : 3

63005/000

Pause entre les appels

Temps d'attente jusqu'au prochain appel après une tentative de 

connexion infructueuse. 

Entrée : 1 à 999 secondes ; réglage par défaut : 60 s

63010/000

Priorité

Déterminez quelle action doit avoir la priorité.

On peut régler ici si l'envoi d'un SMS interrompt la saisie de valeurs 

mesurées (priorité : envoi du SMS) ou si l'on diffère l'envoi jusqu'à ce que 

la saisie soit terminée (priorité : saisie de données).

Liste de sélection : Envoi du SMS, Saisie de données

63012/000
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Type de modem

Indique quel type de modem est raccordé à l'appareil. .

"Modem (tonalité)" : modem standard analogique ou modem ISDM 

avec tonalité. 

"Modem (pulsation)" : modem standard analogique ou modem ISDM 

avec pulsation.

"Terminal GSM" : Modem GSM ou GPRS, téléphone portable.

! Remarque ! 

• Un modem GSM ou GPRS est nécessaire pour l'envoi d'un message 

sous forme de SMS à un téléphone portable. La carte SIM doit être 

libérée pour la réception de données !

• Pour l'envoi d'un message à un PC il est également possible d'utiliser 

un modem standard analogique ou ISDN.

• Le modem doit supporter la séquence d'ordres AT complète.

• Tenir compte de la procédure de mise en service/d'initialisation du 

modem dans le manuel de mise en service sur le CD-ROM fourni.

• Un modem standard ou GSM doit être raccordé à l'interface RS232 de 

l'appareil (ne pas utiliser de duplexeur ou de modem RS485). Utilisez 

exclusivement le câble modem RXU10-A1 (voir accessoires dans la 

manuel de mise en service sur CD-ROM).

• Dans le menu principal sous "Configuration -> Système -> 

Communication -> Interface sérielle" réglez le taux de baud avec 

lequel vous souhaitez transmettre les données.

• Un autre modem (GPRS) peut en outre être raccordé le cas échéant à 

l'interface Ethernet.

63015/000

Code PIN

Uniquement pour "Type de modem" - "Terminal GSM"

En règle générale, après une coupure de l'alimentation, il faut à nouveau 

libérer le terminal GSM en entrant le code PIN. Entrez ici le code PIN de 

votre carte SIM. Pour 0000, le code PIN est désactivé.

Entrée de texte : 4 caractères ; réglage par défaut : 0000

! Remarque ! 

Un code PIN non valable peut entraîner le blocage de la carte SIM. 

De ce fait, il n'est pas possible de recevoir/d'émettre de SMS.

63020/000

Appel d'un centre distant

Uniquement pour "Type de modem" - "Modem (tonalité ou pulsation)"

Pour un modem de réseau connecté à un poste annexe, il faut entrer le 

code correspondant pour l'appel d'un centre distant, par ex. 0. 

Entrée de texte : max. 3 caractères.

63025/000

N° service SMS

Uniquement pour "Type de modem" - "Terminal GSM"

Si un modem GSM est raccordé à l'appareil, le message SMS peut être 

directement envoyé via le N° de service SMS. Le numéro peut être 

obtenu auprès de l'opérateur de téléphonie mobile.

! Remarque ! 

Le n° de service doit être entré avec le préfixe du pays (par ex +33 pour 

la France). En règle générale, le numéro de service figure sur la carte SIM 

et il ne faut pas le saisir. 

Entrée de texte : max. 22 caractères.

63030/000

Positions de menu 

"Application - 

Téléalarme"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code
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Valider le message

Uniquement pour "Type de modem" - "Terminal GSM"

Déterminez si les messages de téléalarme doivent être confirmés par 

SMS.

! Remarque ! 

La position "Envoyer à tous les destinataires" (voir menu "Alarme x") doit 

être réglée sur "non" pour pouvoir utiliser cette fonction.

Liste de sélection : Non, Oui

63035/000

Validation Timeout

Uniquement pour "Valider message" - "oui"

Déterminez à quel moment le destinataire du message doit confirmer le 

message alarme par SMS. Si le destinataire ne confirme pas à temps le 

message, un message est envoyé au prochain destinataire (si défini). 

Entrée : 1 à 9999 ; réglage par défaut : 10

! Remarque ! 

Pour pouvoir acquitter la réception d'un SMS, il faut que le destinataire 

retourne à l'appareil l'ID de message univoque qu'il a obtenu par SMS.

Ceci fonctionne de deux manières (en fonction du téléphone portable) :

1. Sélectionner "Réponses", saisir l'ID manuellement dans le SMS

2. Sélectionner "Transférer" et sélectionner le numéro de téléphone 

dans le carnet d'adresses.

C'est seulement après réception d'un message ID valable par l'appareil 

que le SMS est considéré comme "envoyé avec succès".

63040/000

Appel supplémentaire

Par ailleurs, l'appareil peut appeler le numéro de téléphone destinataire 

du SMS. L'appel est automatiquement terminé lorsque le correspondant 

décroche. La tentative d'appel est interrompue après 60 s si le 

correspondant ne décroche pas.

! Remarque ! 

Cette fonction n'est pas supportée par tous les téléphones portables/

fournisseurs (Il faut que "Appel données" soit supporté).

! Remarque ! 

Fonction seulement judicieuse si le destinataire possède un téléphone 

portable sans numéro masqué ! 

Liste de sélection : Non, Oui

63042/000

Vérifier la réception de SMS

Uniquement pour "Type de modem" - "Terminal GSM"

Déterminez si l'appareil doit vérifier cycliquement si de nouveaux SMS 

ont été réceptionnés (interrogation/commande à distance).

" Attention ! 

Si cette fonction est active, les liaisons de données existantes sont 

automatiquement terminées !

Cette fonction doit être réglée sur "non" lorsqu'un modem GPRS est 

raccordé !

Liste de sélection : Non, Oui

63080/000

Sous-menu "Config. e-mail 

(émetteur)"

Réglages nécessaires si vous souhaitez envoyer des alarmes par e-mail.

! Remarque ! 

Remarque : Les e-mails peuvent être envoyés via Ethernet !

Positions de menu 

"Application - 

Téléalarme"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code
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Host SMTP

Déterminez si vous voulez vous connecter à votre serveur d'e-mail via 

l'adresse IP ou via DNS.

Menu de sélection : Adresse IP; Domain Name System (DNS)

! Remarque ! 

Lors de la sélection "DNS", il faut régler sous "Système -> 

Communication -> Ethernet -> Domain Name System (DNS)" l'adresse 

IP du serveur DNS.

63090/000

Host SMTP

Uniquement pour "SMTP-Host" - "Adresse IP"

Entrez ici votre host SMTP. Adressez-vous le cas échéant à votre 

administrateur de réseau ou à votre fournisseur d'e-mail. 

Entrée de l'adresse IP. Réglage par défaut : 000.000.000.000

63045/000

Host SMTP

Uniquement pour "Host SMTP" - "Domain Name System (DNS)"

Entrez ici votre host SMTP. Adressez-vous le cas échéant à votre 

administrateur de réseau ou à votre fournisseur d'e-mail. Est nécessaire 

si vous souhaitez envoyer des e-mails et remplacer l'adresse IP par le 

nom du serveur e-mail (par ex. smtp.example.org).

Entrée de texte : max. 60 caractères.

63095/000

Port

Entrez ici votre port SMTP. Adressez-vous le cas échéant à votre 

administrateur de réseau ou à votre fournisseur d'e-mail. 

Entrée : max. 4 caractères. Réglage par défaut : 25

63050/000

Emetteur

Entrez ici l'adresse e-mail de l'appareil (ce texte apparaît comme 

expéditeur de l'e-mail). Adressez-vous le cas échéant à votre 

administrateur de réseau ou à votre fournisseur d'e-mail. 

Entrée de texte : max. 60 caractères.

63055/000

Authentification

Si votre serveur/fournisseur d'e-mails requiert une authentification, 

sélectionner ici "Oui". Adressez-vous le cas échéant à votre 

administrateur de réseau ou à votre fournisseur d'e-mail. 

Liste de sélection : Non, Oui

! Remarque ! 

Les procédures d'authentification suivantes sont supportées et 

automatiquement reconnues : PLAIN, LOGIN et CRAM-MD5.

63065/000

Nom d'utilisateur

Uniquement pour "Authentification" - "oui"

Entrez ici le nom d'utilisateur du compte e-mail. Adressez-vous le cas 

échéant à votre administrateur de réseau ou à votre fournisseur d'e-mail. 

Entrée de texte : max. 60 caractères.

63060/000

Mot de passe

Uniquement pour "Authentification" - "oui"

Entrez ici le mot de passe pour l'authentification. Adressez-vous le cas 

échéant à votre administrateur de réseau ou à votre fournisseur d'e-mail. 

Entrée de texte : max. 22 caractères. 

63070/000

Positions de menu 

"Application - 

Téléalarme"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code
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Sous-menu "Numéros de 

téléphone"

Saisissez ici tous les numéros de téléphone auxquels doit être envoyé un 

message en cas d'alarme.

! Remarque ! 

L'affectation aux alarmes a lieu ultérieurement.

Numéros 1-20

Saisissez ici un numéro de téléphone auquel doit être adressé un 

message. 

Entrée max. 22 caractères.

! Remarque ! 

Chez certains fournisseurs, il est également possible d'envoyer des 

e-mails par SMS. Pour ce faire il faut ajouter à un numéro de téléphone 

spécial un signe @, suivi des numéros de l'adresse e-mail (1-20 dans le 

sous-menu "Adresses e-mail"). Exemple T-Mobile : 8000187@1

63101/000 à 

63120/000

Sous-menu "Adresses e-mail" Saisissez ici toutes les adresses e-mail auxquelles doit être envoyé un 

message en cas d'alarme.

Adresses e-mail 1-20

Saisissez ici une adresse e-mail à laquelle doit être adressée un message.

Entrée de texte dans le format suivant : "x@y.z", min. 5 caractères, max. 

60 caractères.

63201/000 à 

63220/000

Sous-menu "Envoyer un 

e-mail après analyse"

Déterminez si un e-mail doit être envoyé à la fin d'une analyse. L'e-mail 

contient les données de l'analyse dans un fichier CSV joint. Le format du 

fichier CSV peut être modifié sous "Configuration -> Système -> 

Mémoire externe".

! Remarque ! 

En cas d'erreur (mauvais paramétrage, serveur e-mail injoignable…), 

l'e-mail n'est pas renvoyé.

Exploitation 1-4

Liste de sélection : Oui, Non

63500/000 à 

63503/000

Sélectionner destinataire 1 -2

Sélectionnez à qui l'analyse doit être envoyée. 

Liste de sélection : non utilisé, numéro de téléphone xx, adresse e-mail 

xx

63510/000 à 

63511/000

Sous-menu "Alarme 1" 

à "Alarme 35"

Déterminez le réglage pour cette alarme.

Remarque : Les menus "Alarme x" apparaissent seulement lorsqu'au moins une adresse e-mail ou numéro de 

téléphone a été entré.

Fig. 4: Configuration - Application - Téléalarme, sous-menu "Alarme 1"

Positions de menu 

"Application - 

Téléalarme"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code
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Déclenchement Déterminez quel seuil ou voie commande l'alarme.

Liste de sélection : désactivée, Seuil x, Analog x, Digital x, Mathe x

! Remarque ! 

Entrée digitale x : uniquement pour message marche/arrêt ;

Mathe x : uniquement pour "Résultat est" = "état"

63300/000 à 

63300/034

Envoyer à tous les 

destinataires

"non" : Après un appel réussi, aucun numéro de téléphone n'est appelé 

ni aucun e-mail n'est envoyé pour l'alarme.

"oui" : En fonction téléalarme, tous les numéros de téléphone réglés sont 

appelés et tous les e-mails envoyés.

63305/000 à 

63305/034

Déclenchement pour

Uniquement pour 

"Déclenchement" - "Entrée 

digitale x" ou "Mathe x"

Alarme à l'enclenchement (L->H) ou au déclenchement (H->L) de 

l'entrée numérique.

Liste de sélection : Changement d'état L->H, changement de flanc 

H->L, L->H et H->L

63310/000 à 

63310/034

Destinataire 1 Définissez à qui doit être envoyé un message (logiciel PC, e-mail ou 

fournisseur de téléphonie mobile).

Liste de sélection : non utilisé, logiciel PC, e-mail, téléphone portable

Logiciel PC : Si le message doit être envoyé à un PC, ce dernier doit être 

raccordé à un modem et le logiciel PC fourni doit se trouver en mode 

automatique. Le message est affiché à l'écran du PC et peut être imprimé 

sur une imprimante raccordée ou transféré par e-mail (voir manuel de 

mise en service ou la fonction d'aide du logiciel PC fourni).

E-mail : Le message est envoyé par e-mail sous forme de "texte clair". 

Aucun e-mail avec pièces jointes n'est envoyé. En cas de problèmes de 

transmission, 3 tentatives d'émission sont faites à 5 minutes d'intervalle. 

Sujet des e-mails : nom de l'appareil <Device Tag>.

Téléphone portable : Le message est envoyé par SMS à un téléphone 

portable. (sélection possible uniquement si sous "Généralités -> Config. 

SMS / logiciel PC -> Type de modem :", on a choisi "Terminal GSM".)

! Remarque ! 

Les messages émis et les défauts de transmission sont inscrits au journal 

des événements.

63315/000 à 

63315/034

Sélectionner destinataire 1 

Uniquement si "Destinataire 1" 

est sélectionné

Sélectionnez qui doit être prévenu en cas d'alarme.

Liste de sélection : non utilisé, numéro de téléphone x, adresse e-mail x

! Remarque ! 

Peut seulement être sélectionné si un numéro ou une adresse e-mail a 

déjà été entré (voir "Application -> Téléalarme -> Généralités -> 

Numéros de téléphone/adresses e-mail")

63320/000 à 

63320/034

Destinataire 2 (voir "Destinataire 1") 63325/000 à 

63325/034

Sélectionner destinataire 2

Uniquement si "Destinataire 2" 

est sélectionné

(voir "Sélectionner destinataire 1") 63330/000 à 

63330/034

Destinataire 3 (voir "Destinataire 1") 63335/000 à 

63335/034

Sélectionner destinataire 3

Uniquement si "Destinataire 3" 

est sélectionné

(voir "Sélectionner destinataire 1") 63340/000 à 

63340/034

Destinataire 4 (voir "Destinataire 1") 63342/000 à 

63342/034

Positions de menu 

"Application - 

Téléalarme"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code
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2.3 Configuration - Système - Analyse du signal

(statistique alarme)

Réglages permettant d'obtenir une exploitation des signaux sur des périodes/cycles de temps 

réglables ainsi que la fonction pour la remise à zéro manuelle des exploitations des signaux.

! Remarque ! 

Seuls sont décrits les réglages intéressants pour le mode téléalarme. Pour toutes les autres fonctions 

de l'exploitation de signal, voir Manuel de mise en service sur CD-ROM.

! Remarque ! 

Selon la fonction choisie, l'interface utilisateur s'adapte de sorte que seuls les paramètres nécessaires 

à un fonctionnement sûr de l'appareil doivent être vérifiés/réglés.

Fig. 5: Configuration - Système - Analyse du signal - Statistique alarme

Sélectionner destinataire 4

Uniquement si "Destinataire 4" 

est sélectionné

(voir "Sélectionner destinataire 1") 63343/000 à 

63343/034

Copier config. Copie les réglages actuels dans la téléalarme sélectionnée.

Liste de sélection : non, dans alarme x

63345/000 à 

63345/034

Positions de menu 

"Application - 

Téléalarme"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code
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2.4 Configuration - Système - Communication - Ethernet

Réglage nécessaire si vous utilisez l'interface Ethernet de l'appareil.

! Remarque ! 

Seuls sont décrits les réglages intéressants pour le mode téléalarme. Pour tous les autres réglages 

relatifs à Ethernet, voir Manuel de mise en service sur CD-ROM.

Positions de menu 

"Système - Analyse du 

signal"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code

Statistique alarme Par le biais des cycles d'exploitation de signal (par ex. exploitation journalière), il est possible de déterminer 

les données suivantes :

• Combien de fois le seuil a-t-il été dépassé (fréquence)

• Quelle est la durée du dépassement de seuil (durée au format horaire 0000h00:00)

Liste de sélection : Non, Oui

! Remarque ! 

• La statistique alarme est générée pour chaque exploitation de signal active (même durée). Dans le cas 

d'exploitations de signal externes, aucune statistique d'alarme n'est générée pour la durée pendant 

laquelle l'exploitation n'est pas active.

• La statistique alarme est seulement générée pour les seuils "analogiques" (haut, bas ou gradient). Aucune 

statistique n'est générée pour les "seuils sur compteur".

• Des seuils peuvent être affectés aux données de la statistique alarme. Ces seuils peuvent surveiller la 

fréquence ou la durée du dépassement pendant l'exploitation de signal. Paramétrage sous "Configuration 

-> Application -> Seuils -> Seuil x -> Voie ou type " (voir manuel de mise en service sur CD-ROM 

fourni).

• Pour l'option "Déversoir d'eau de pluie RÜB", il faut sélectionner ici "oui".

17030/000

Regrouper des jours

(uniquement pour 

"Statistique alarme" - "oui")

Déterminez comment doit être établie la fréquence pour les exploitations hebdomadaires, mensuelles ou 

annuelles.

"Non" : Tous les dépassements de seuil sont comptés.

"Oui" : On représente le nombre de jours pendant la période d'exploitation au cours desquels a eu lieu au 

moins un dépassement de seuil (par ex. nécessaire pour la fréquence d'épandage du déversoir d'eau de 

pluie). 

Liste de sélection : Non, Oui

! Remarque ! 

Pour l'option "Déversoir d'eau de pluie RÜB", il faut sélectionner ici "oui".

17040/000

Positions de menu 

"Système - Communication 

- Ethernet"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code

Domain Name System (DNS) Entrez ici l'adresse IP d'un serveur DNS (disponible auprès de votre administrateur de réseau).

Réglage par défaut : 000.000.000.000

Est nécessaire si vous souhaitez envoyer des e-mails et remplacer l'adresse IP par le nom du serveur 

e-mail (par ex. smtp.example.org).

14345/000
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2.5 Configuration - Sorties - Relais

Configuration des relais pour la fonction téléalarme

Pour l'option "Téléalarme", il est possible de commander les relais de l'appareil à distance. A l'aide 

d'un téléphone portable ou d'un PC, il est possible, via la commande à distance des relais de 

l'appareil, de piloter un signal acoustique ou optique ou encore une pompe avant qu'une personne 

ne se trouve sur place.

! Remarque ! 

Seuls sont décrits les réglages intéressants pour le mode téléalarme. Pour toutes les autres fonctions 

des sorties relais, voir Manuel de mise en service sur CD-ROM.

Fig. 6: Configuration - Sorties - Relais - Relais x - Commande à distance

Positions de menu 

"Sorties - Relais - 

Relais x"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code

Commande à distance Déterminez si le relais doit être commandé à distance (par ex. PC ou SMS).

Liste de sélection : Non, Oui

! Remarque ! 

• Le relais correspondant ne peut alors pas être utilisé à d'autres fins, par ex. surveillance de seuil.

• Les désignations pour les relais peuvent être réglées dans l'appareil (voir manuel de mise en service sur le 

CD-ROM fourni). 

• La commande à distance de relais est inscrite au journal des événements. 

• Avec une gestion des utilisateurs active : le dernier utilisateur connecté reste connecté. Si aucun utilisateur 

n'est connecté, aucun utilisateur ne le sera via la commande à distance. Dans le journal des événements 

apparaît qui a commandé le relais à distance.

• Le dernier état (ON ou OFF) des relais est maintenu après une coupure de l'alimentation.

Principe de fonctionnement :

Par PC : Les relais de l'appareil peuvent être mis en marche/arrêt à l'aide du logiciel PC fourni sous "Divers 

-> Fonctions spéciales -> (sélectionner appareil) -> Commande à distance". Lorsque la gestion des utilisateurs 

est active, il convient de valider chaque action au moyen de l'ID et du mot de passe (issu de la gestion des 

utilisateurs). L'action est effectuée uniquement si le mot de passe est correct. L'utilisateur doit disposer des 

droits nécessaires dans la gestion des utilisateurs (voir manuel de mise en service sur le CD-ROM fourni).

Par serveur OPC : Les relais de l'appareil peuvent être mis en marche/arrêt ("commande à distance") à l'aide 

du serveur OPC optionnel. Lorsque la gestion des utilisateurs est active, on emploie l'utilisateur suivant pour 

le journal des événements/Audit Trail : "ID: Remote, Name: OPC".

Par PROFIBUS / Modbus : Les relais de l'appareil peuvent être mis en marche/arrêt ("commande à distance") 

via PROFIBUS / Modbus (Option). la gestion des utilisateurs est active, on emploie l'utilisateur suivant pour 

le journal des événements/Audit Trail : "ID: Remote, Name: Fieldbus".

52015/000 à 

52015/011
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! Remarque ! 

Les réglages modifiés ne sont effectifs que lorsque vous retournez au mode de fonctionnement 

normal en appuyant plusieurs fois sur "Retour" (confirmer l'acceptation de la configuration avec 

"Oui"). Jusqu'à ce moment, l'appareil fonctionne encore avec les données précédentes.

2.6 Utilisation

2.6.1 Messages en cas d'alarme

En cas d'alarme, un message par alarme est envoyé au destinataire sélectionné ; le contenu est le 

suivant :

• Date/heure (dans le format réglé à l'appareil) ;

• Non d'appareil saisi <Device Tag>;

• Message univoque de 10 caractères généré par l'appareil (uniquement pour SMS si la fonction 

"valider message" est active)

• Message selon la raison du déclenchement :

Exemple d'un message d'alarme complet : "24.09.2008 15:23:16 <nom de l'appareil> 

Analogique 5 > 50,0 %"

Par SMS : Les relais de l'appareil peuvent être mis en marche/arrêt via SMS ("commande à distance ").

! Remarque ! 

Un modem GSM doit être relié à l'appareil pour pouvoir réceptionner les SMS. On accède à l'appareil par SMS 

(authentification) uniquement via les numéros de téléphone stockés dans l'appareil. Pour ce faire, il faut 

désactiver la suppression des numéros d'appel par téléphone portable ! Lorsque la gestion des utilisateurs est 

active, on emploie l'utilisateur suivant pour le journal des événements/Audit Trail : "ID: SMS, Name: 

<Numéro de téléphone>".

Le texte SMS suivant doit être envoyé par l'utilisateur pour pouvoir commuter un relais :

Ouvrir : RELAY<nr>=ON (exemple : "RELAY3=ON" ouvre le relais n° 3)

Fermer : RELAY<nr>=OFF (exemple : "RELAY3=OFF" ferme le relais n° 3)

Remarque : <nr> est le numéro de relais (1..12) ; par SMS on peut commander max. 1 relais.

Ces commandes sont générées à partir du mode de fonction "Contact de fermeture". Lorsque le relais travaille 

en mode de fonction "Contact d'ouverture", les commandes entraînent le résultat contraire. La commande ne 

doit pas comporter des espaces. Les commandes sont reconnues indépendamment du fait qu'elles sont écrites 

en majuscules ou minuscules.

L'expéditeur reçoit en retour un message d'état par SMS.

Positions de menu 

"Sorties - Relais - 

Relais x"

Paramètres réglables
(réglages par défaut en gras)

Direct 

Access Code

Raison du déclenchement Contenu du SMS ou de l'e-mail

Dépassement de seuil Le texte saisi sous "Configuration -> Application -> Seuils -> Seuil x -> Texte seuil on" est envoyé. En l'absence d'un 

message, l'appareil génère automatiquement un texte propre univoque (par ex. "Analogique 1 > 90%").

Commutation des entrées 

numériques

Le texte saisi sous "Configuration -> Entrées -> Entrées digitales -> Entrée digitale x" pour "L->H" ou "H->L" est envoyé. 

En l'absence d'un message, l'appareil génère automatiquement un texte propre univoque (par ex. "digitale 1 L->H").

! Remarque ! 

Fonction possible uniquement si "Message on/off" ou "Message + Temps de fonctionnement" a été sélectionné pour 

l'entrée numérique.
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2.6.2 Exemple Transférer messages alarme / SMS

Procédure pour l'activation du transfert de téléalarme :

1. Activer la téléalarme sous "Setup -> Application -> Téléalarme-> Généralités"

2. Réglages nécessaires sous "Configuration -> Application -> Téléalarme -> Généralités -> 

Config. SMS / logiciel PC" :

Type de modem : sélectionner "Terminal GSM

Valider le message sélectionné : sélectionner "oui"

Validation Timeout : régler par ex. "10 minutes"

3. Créer au moins 2 numéros de téléphone sous "Configuration -> Application -> Téléalarme -> 

Généralités -> Numéros de téléphone"

4. Réglages nécessaires sous "Configuration -> Application -> Téléalarme -> Alarme x" :

Envoyer à tous les destinataires : "non"

Destinataires x : "Téléphone portable". Remarque : Affectation à au moins 2 destinataires.

Déroulement dans le cas d'une alarme :

1. L'appareil envoie les SMS au premier destinataire réglé (par ex. Destinataire 1)

2. Si celui-ci ne valide pas par SMS durant la période réglée ("Validation Timeout" par ex. 

10 minutes), l'appareil envoie automatiquement les SMS au prochain destinataire réglé (par ex. 

Destinataire 2) ("Transfert")

3. Si ce destinataire valide le message durant la période réglée ("Validation Timeout" par ex. 

10 minutes), le message téléalarme est clos.

4. Si ce destinataire ne valide pas non plus à temps, l'appareil envoie le SMS au prochain 

destinataire réglé. Si aucun destinataire n'est réglé, l'appareil émet un message erreur, une 

entrée est mémorisée dans le journal des événements et si on a réglé "Configuration -> 

Application -> Téléalarme -> Généralités, pour défaut :", un relais est commuté.

Fig. 7: Déroulement en cas d'alarme : envoyer et acquitter le message alarme par SMS.

! Remarque ! 

Pour pouvoir acquitter la réception d'un SMS, il faut que le destinataire retourne à l'appareil l'ID de 

message univoque qu'il a obtenu par SMS.

Ceci fonctionne de deux manières (en fonction du téléphone portable) :

1. Sélectionner "Réponses", saisir l'ID manuellement dans le SMS

2. Sélectionner "Transférer" et sélectionner le numéro de téléphone dans le carnet d'adresses.

C'est seulement après réception d'un message ID valable par l'appareil que le SMS est considéré 

comme "envoyé avec succès".

" Attention ! 

En présence de plusieurs événements simultanés, ceux-ci sont envoyés successivement. On pourra 

alors avoir une temporisation dans l'acheminement du message (pas d'alarme en temps réel).

t

Pause 
entre 

les appels

Pause 
entre 

les appels
Temps pour la validation 

de l'alarme

Validation Timeout Validation Timeout

Alarme n'a pas 
été validée

1ère tentative 
d'appel

2ème tentative 
d'appel

3ème tentative 
d'appel

Prochain destinataire 
ou relais alarme

Moment 
de l'alarme

SMS n'a pas pu 
être envoyé

SMS n'a pas pu 
être envoyé

SMS a été 
envoyé
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2.6.3 Interroger les valeurs par téléphone portable/SMS

Les valeurs momentanées de différents voies et groupes ainsi que les exploitations de l'appareil 

peuvent être interrogées par SMS.

! Remarque ! 

La langue du message est toujours l'anglais.

! Remarque ! 

Un modem GSM doit être relié à l'appareil pour pouvoir réceptionner les SMS. Cette fonction est 

possible uniquement sous certaines conditions avec un modem GPRS. On accède à l'appareil par 

SMS (authentification) uniquement via les numéros de téléphone stockés dans l'appareil. Pour ce 

faire il faut désactiver la suppression des numéros d'appel par téléphone portable ! Lorsque la gestion 

des utilisateurs est active, on emploie l'utilisateur suivant pour le journal des événements/Audit 

Trail : "ID: SMS, Name: <Numéro de téléphone>".

! Remarque ! 

La commande ne doit pas comporter des espaces. La commande est reconnue indépendamment du 

fait qu'elle est écrite en majuscules ou minuscules. Dans le cas de commandes invalides (mauvais 

format, voies/groupes inconnus, voie désactivée, exploitation désactivée, ...) un message erreur est 

envoyé par SMS à l'expéditeur (sauf en cas d'authentification erronée). Par SMS, on peut interroger 

1 valeur ou les valeurs d'un groupe.

Interroger les valeurs momentanées et les exploitations de différentes voies

Le texte de SMS suivant doit être envoyé par l'utilisateur pour pouvoir interroger une valeur par 

SMS :

Exemple :

Un SMS avec le texte "GETA;8;1" interroge la valeur momentanée à partir de la voie analogique 8.

Un SMS avec le texte "GETM;1;6" interroge le compteur totalisateur de l'exploitation 1 à partir de 

la voie mathématique 1.

Construction de la réponse par SMS :

<Date/heure>

<Device Tag> (désignation de l'appareil)

<Désignation de voie> = <Valeur> <Dim> [(<Type de compteur>)]

<Date/heure>

<Device Tag> (désignation de l'appareil)

message erreur

Exemple d'une réponse par SMS : 

05.10.2008 15:08:00

<Device Tag> (désignation de l'appareil)

Cuve1 = 20 m

Légende :

<Date/heure> = moment auquel les valeurs momentanées ont été mesurées (dans le format réglé 

dans l'appareil)

<Désignation de voie> = Désignation de voie

<Valeur> = valeur mesurée

<Dim> = Unité/Dimension

<Type de compteur> = Type de l'exploitation (en option, c'est-à-dire seulement lorsque le 

compteur a été interrogé)

GET <typ> Type de voie : <ch> Numéro de voie : <mode> Nature de la valeur mesurée :

GET A; Voie analogique 1...40; 1 Valeur instantanée

GET D; Voie numérique 1...14; 2 Etat compteur exploitation 1

GET M; Voie mathématique 1...8; 3 Etat compteur exploitation 2

GET 4 Etat compteur exploitation 3

GET 5 Etat compteur exploitation 4

GET 6 Compteur totalisateur
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Interroger les valeurs d'un groupe

Le texte de SMS suivant doit être envoyé par l'utilisateur pour pouvoir interroger une valeur 

momentanée d'un groupe par SMS :

Par SMS on peut interroger au maximum les valeurs d'un groupe. Sont délivrées en retour les 

valeurs mesurées (momentanées/compteur) qui sont également affichées dans le groupe.

Cas particulier : Si une valeur mesurée est affichée en alternance (c'est-à-dire qu'on affiche en 

alternance la valeur momentanée et le compteur), seule la valeur momentanée est envoyée.

Un SMS peut contenir au max. 160 caractères. Si la réponse dépasse ce nombre, elle est répartie sur 

plusieurs SMS.

Construction de la réponse

Si OK :

<Date/heure>

<Désignation des appareils>

<Désignation du groupe>

Pour chaque voie du groupe : <No> = <Val> <Dim>

Si erreur :

< Date/heure> : message d'erreur

Légende :

<No> : voie du groupe (1..8)

<Valeur> : valeur mesurée

<Dim>: Unité/Dimension

2.6.4 Journal des événements / Audit Trail

En cours de fonctionnement, il est possible d'afficher le journal des événements en activant la 

touche 1 ou via "Menu principal -> Affichage / Fonctionnement -> Journal des événements / Audit 

Trail" :

Fig. 8: Journal des événements / audit trail

Les événements suivants peuvent être visualisés ici :

• Messages envoyés et erreurs de transmission

• Test de la fonction téléalarme

• Commande à distance de relais

• Interrogation des valeurs momentanées par SMS

• En cas de gestion des utilisateurs active, authentification réussie ou échouée via la commande à 

distance (avec numéro d'utilisateur)

GROUP <no> Numéro de groupe :

GROUP 1...10 Numéro du groupe



Réglage de l'appareil, configuration de l'application Graphic Data Manager

20

Pour ce faire, sélectionnez l'entrée correspondante dans le journal des événements et activez la 

touche 3 "Détails". Pour revenir à l'affichage de la valeur instantanée, appuyez sur la touche 

programmable 1 "Esc".

2.6.5 Statistique alarme dans l'exploitation de signal

En cours de fonctionnement, on peut afficher l'exploitation du signal avec la statistique alarme en 

activant la touche 4 ou via "Menu principal -> Options -> Analyse du signal" :

Fig. 9: Analyse du signal avec statistique alarme

On affiche ici la statistique alarme en plus de l'exploitation de signal sélectionnée (voir manuel de 

mise en service sur le CD-ROM fourni).

Pour revenir à l'affichage de la valeur instantanée, appuyez sur la touche programmable 1 "Esc".

! Remarque ! 

La statistique alarme est remise à zéro par le biais de l'exploitation de signal normale "Configuration 

-> Système -> Exploitation du signal -> Remise à zéro".

Les données de la statistique alarme peuvent être représentées dans le logiciel PC fourni (dans le 

tableau des valeurs mesurées), imprimées et exportées.

2.6.6 Vérifier/afficher la qualité de réception

L'appareil vérifie la qualité de réception (intensité de champ) du modem GSM raccordé et indique 

le réseau GSM actuel (fournisseur). Les informations sont affichées dans "Menu principal -> 

Diagnostic / Simulation -> Terminal GSM".

! Remarque ! 

Cette fonction est seulement disponible si un modem GSM est raccordé et si le modem supporte les 

commandes correspondantes.

2.6.7 Etat téléalarme

L'appareil affiche les informations sur l'état des différentes alarmes. Les informations sont affichées 

dans "Menu principal -> Diagnostic / Simulation -> Etat téléalarme".

! Remarque ! 

Cette fonction est seulement disponible si la téléalarme a été activée et entièrement paramétrée sous 

"Configuration -> Application -> Téléalarme".

2.6.8 Fonction de test des relais commandés à distance

Avec la fonction suivante, il est possible d'activer manuellement les relais libérés pour la commande 

à distance : "Menu principal -> Diagnostic / Simulation -> Simulation -> Relais". Sélectionnez le 

relais correspondant et modifiez l'état (ouvert/fermé).
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! Remarque ! 

La modification de l'état figure dans le journal des événements.

Avec une gestion des utilisateurs active : L'utilisateur doit disposer des droits nécessaires dans la 

gestion des utilisateurs (voir manuel de mise en service sur le CD-ROM fourni).

2.6.9 Fonction de test relative à l'envoi de SMS/e-mails

Avec la fonction suivante, on peut tester l'alarme (envoi de SMS/e-mails) : "Menu principal -> 

Diagnostic / Simulation -> Simulation -> Tester la téléalarme"

Sélectionnez l'une des alarmes réglées. Ensuite l'appareil envoie un message (SMS ou e-mail, selon 

le réglage) à TOUS les destinataires identifiés (validation n'est pas prise en compte lors du test). 

Un texte neutre est utilisé pour le message (Alarme <x> : Test), afin que les destinataires puissent 

reconnaître qu'il s'agit d'un test. Le test figure dans le journal des événements.

3 Messages d'erreur et suppression des défauts

Votre appareil vous informe en cas de défaut ou d'entrée erronée à l'aide d'un texte en clair à l'écran. 

Si un défaut se produit dans l'appareil, la LED rouge s'allume. En cas d'avertissements ou d'un 

besoin de maintenance, la LED rouge clignote. En option, c'est-à-dire en cas d'activation dans la 

configuration (standard = off), la LED rouge peut également clignoter en cas d'alarme de seuil. 

! Remarque ! 

Une description précise des défauts avec leurs solutions se trouve au chapitre 9 du manuel de mise 

en service (voir CD-ROM fourni).

4 Caractéristiques techniques

! Remarque ! 

Les caractéristiques techniques du manuel de mise en service sur le CD-ROM fourni est valable pour 

cette option d'appareil.
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